How to change pdf file name in excel

I have a bunch of product image files, named with their EAN-codes(barcodes). We have this big client who wants their product images named with their own article number and not with the EAN-Code. In this example, I have only 16 images but in the actual case I had 300 images that I renamed by hand at the time and I REALLY REALLY didn't want
to rename every file by hand every time I have to send files to that client.So, I knew that I had an Excel file that contains the EAN-Codes, product names, and the associated Article Number, and I sure as shit lacked the enthusiasm to do this time-consuming endeavor every time. I knew there's got to be a way to utilize the data that a had in one go,
with minimal manual work. Or more like hoped there would be something that could make my life a whole lot easier.So I embarked on a mission to find an easy way to rename multiple files in batch with Excel data. Apparently there were a few different ways that I could approach this dilemma but I decided to go with the tools that I got, it turned out
that all I needed was an Excel and command prompt.The Command Prompt is used to copy filename list if needed and for running the renaming processThe Excel is used to manipulate the filenames the way we want and compiling the renaming commands for the Command Prompt For starters, I will show a few tricks that I picked up when searching
for the answer. These might come in handy at some point. In my case, I didn't need a copy a list of my files so I could manipulate the filenames because they were already named with the EAN-Codes that I had in my excel so it was easy to make the filenames from that information but I will show you a way to use CMD Prompt to copy a list of filenames
from a specific folder. Next I will show you some tricks that you can do to modify the filenames before you rename the files. We will be talking about how to separate filename and the file extension, how to add and replace things to the name with Excel functions. So Let's open Microsoft Excel and get those filenames in there. The actual renaming
process is done with Command Prompt using the filenames we just have modified. We only need to do one more Excel trick to prepare our filenames so they'll be ready to use. Rename commandThe renaming command in Command Prompt goes like this "ren the-old-filename.jpg the-new-filename.jpg" What we need to do in Excel is to organise the
data that we have to form that command. Hope this helped you as much it did me. If you have questions feel free to write a comment below. © Bad Luck Company 2019-2022 - All Rights Reserved. Renaming multiples files on your Windows computer is easy. Select all the files, press F2 and type some descriptive text. Windows will append a unique
sequence number to each of the file names.That’s a fairly quick solution but not very flexible because you don’t get to specify any choices or criteria.For instance, how do you append the current date to the filename ? Or you want to replace only certain words in the file names (like a spelling error)? Or you want files to follow a different renaming
system like file-A.jpg instead of the default file(1).jpg.To rename files in bulk more efficiently, you can either learn some complex shell scripting language (SED, AWK, Perl) or switch to something more simple - a spreadsheet. Step 1: Type cmd and switch (using “cd” command) to the directory that contains the files you want to rename in bulk.Step 2:
Type “dir /b” to see a skeleton list of all files in the current directory. Copy that file list to the clipboard by selecting Mark from the contextual menu.Step 3: The fun starts now. Fire your copy of Microsoft Excel or Google Docs Spreadsheets and paste those file names into the first spreadsheet column.Step 4: In the blank adjacent column, add a
corresponding Excel function - for instance, use SUBSTITUTE to change specific text in the filenames, use CONCATENATE() with DATE() if you want to add date to the filename, etc.*For more complex criteria, you may want to put the file extensions in a separate column by splitting the file name using period (.) as the delimiter.Step 5: Your source
filenames are now in column A while the Destination files are in column B - we will now convert this into a DOS rename command.In Column C, type the following Excel formula and your command is ready to be executed.\=CONCATENATE(“ren “,A1, ” ”, B1)Copy paste the same formula across all cells in column C for which you have corresponding
values in Column A or B.We are almost done. Copy all the values from column C to the clipboard and paste them inside the DOS window or better still, put them inside a new text file and give it a name like rename.bat.Execute and all files that match the criteria are renamed instantly.More useful DOS Commands MS-Excel / General FormattingOpen
Excel, but not the file you want to rename. Click the Office Button> Open. The Open or Save As dialog box appears. Optionally, click the Office Button> Save As and continue as described.If necessary, click the Look In list and navigate to the folder containing the file you want to delete.Right click the file. Do not double click the file because double
clicking the file opens it.Choose Rename from the shortcut menu. The original filename becomes highlighted.Type the new file name. Filenames cannot contain asterisk, slash, blackslash, or question mark characters.Press Enter when you are finished typing.Click the Cancel button to close the Open dialog box.The Excel workbook files are subject to
the same rules that apply to other Windows files. A filename can be up to 255 characters, including spaces. This length enables you to give meaningful names to your files. You can't, however, use any of the following characters in your filenames:\ (backslash)? (question mark): (colon)* (asterisk)" (quote)< (less than) > (greater than)| (vertical bar)You
can use uppercase and lowercase letters in your names to improve readability. The filenames are not case sensitive-My 2004 Invoice.xlsx and MY 2004 INVOICE.xlsx are equivalent names.Delete a FileOpen Excel, but not the file you want to delete. Choose Office Button> Open or Office> Save As. Either the Open or Save As dialog box appears.If
necessary, click the Look In list and navigate to the folder containing the file you want to delete.Right click on the unwanted file. Do not double click the file.Choose Delete from the shortcut menu. A confirmation message appears.Click Yes. Excel deletes the file.Click the Cancel button to close the Open or Save As dialog box.Set the Default File
LocationsClick the Office Button and click Excel Options. (It's located at the bottom of the Office list.) The Excel Options dialog box opens.From the options on the left side of the dialog box, click the Save category. You see the options.In the Default file location, enter the data path to the place where you want to save most of your files. Click ok.
[Previous] [Contents] [Next] This will help with getting the start of last month within your code as well as selecting the last month in the slicer. The way you had it, you would have to keep adding new months as they get added to your data. In terms of the copy/paste, there are tons of posts on this and depends if you need to clear out the existing
content. Dim lastMonth As Date Dim startLastMonth As Date Dim startLastMonthSlicerTxt As String Dim startLastMonthFileTxt As String Dim fileName As String ' this would be the generic part of the file name without the date fileName = "my file name " ' subtract a month from current date lastMonth = DateAdd("m", -1, Date) ' set the date to the
1st of last month startLastMonth = DateSerial(Year(lastMonth), Month(lastMonth), 1) ' convert the date to text so you can use in slicer name startLastMonthSlicerTxt = Format(startLastMonth, "d/mm/yyyy") ' convert the date to text so you can use in file name startLastMonthFileTxt = Format(startLastMonth, "d-mm-yyyy") ' this appends the date and
file extension to your generic file name fileName = fileName & startLastMonthTxt & ".xlsx" ' as per your code, we now activate the Window but this time using the dynamic file name Windows(filename).Active ' loop through the slicer items and only select if value matches last month With ActiveWorkbook.SlicerCaches("Slicer_Month") For Each si In
.SlicerItems If si.Name = startLastMonthTxt Then si.Selected = True Else si.Selected = False End If Next si End With On my first day in my job in a small consulting firm, I was staffed on a short project for three days. The work was simple. There were many folders on the network drive and each folder had hundreds of files in it. I had to follow these
three steps: Select the file and copy its name. Paste that name in a cell in Excel and hit Enter. Move to the next file and repeat step 1 & 2. Sounds simple right? It was – Simple and a huge waste of time. What took me three days could have been done in a few minutes if I knew the right techniques. In this tutorial, I will show you different ways to make
this entire process super fast and super easy (with and without VBA). Limitations of the methods shown in this tutorial: With the techniques shown below, you will only be able to get the names of the files within the main folder. You will not get the names of the files in the sub-folders within the main folder. Here is a way to get names of files from
folders and sub-folders using Power Query Using FILES Function to Get a List of File Names from a Folder Heard of FILES function before? Don’t worry if you haven’t. It is from the childhood days of Excel spreadsheets (a version 4 formula). While this formula does not work in the worksheet cells, it still works in named ranges. We will use this fact to
get the list of file names from a specified folder. Now, suppose you have a folder with the name – ‘Test Folder‘ on the desktop, and you want to get a list of file names for all the files in this folder. Here are the steps that will give you the file names from this folder: In cell A1, enter the folder complete address followed by an asterisk sign (*) For
example, if your folder in the C drive, then the address would look like C:\Users\Sumit\Desktop\Test Folder\* If you are not sure how to get the folder address, use the following method: In the folder from which you want to get the file names, either create a new Excel Workbook or open an existing workbook in the folder and use the below formula in
any cell. This formula will give you the folder address and adds an asterisks sign (*) at the end. Now you can copy-paste (paste as value) this address in any cell (A1 in this example) in the workbook in which you want the file names. =REPLACE(CELL("filename"),FIND("[",CELL("filename")),LEN(CELL("filename")),"*") [If you have created a new
workbook in the folder to use the above formula and get the folder address, you may want to delete it so that it doesn’t feature in the list of files in that folder] Go to the ‘Formulas’ tab and click on the ‘Define Name’ option. In the New Name dialogue box, use the following details Name: FileNameList (feel free to choose whatever name you like)
Scope: Workbook Refers to: =FILES(Sheet1!$A$1) Now to get the list of files, we will use the named range within an INDEX function. Go to cell A3 (or any cell where you want the list of names to start) and enter the following formula: =IFERROR(INDEX(FileNameList,ROW()-2),"") Drag this down and it will give you a list of all the file names in the
folder Want to Extract Files with a Specific Extension?? If you want to get all the files with a particular extension, just change the asterisk with that file extension. For example, if you want only excel files, you can use *xls* instead of * So the folder address that you need to use would be C:\Users\Sumit\Desktop\Test Folder\*xls* Similarly, for word
document files, use *doc* How does this work? FILES formula retrieves the names of all the files of the specified extension in the specified folder. In the INDEX formula, we have given the file names as the array and we return the 1st, 2nd, 3rd file names and so on using the ROW function. Note that I have used ROW()-2, as we started from the third
row onwards. So ROW()-2 would be 1 for the first instance, 2 for the second instance when the row number is 4, and so on and so forth. Watch Video – Get List of File Names from a Folder in Excel Using VBA Get a List of All the File Names from a Folder Now, I must say that the above method is a bit complex (with a number of steps). It’s, however, a
lot better than doing this manually. But if you’re comfortable with using VBA (or if you’re good at following exact steps that I am going to list below), you can create a custom function (UDF) that can easily get you the names of all the files. The benefit of using a User Defined Function (UDF) is that you can save the function in a personal macro
workbook and reuse it easily without repeating the steps again and again. You can also create an add-in and share this function with others. Now let me first give you the VBA code that will create a function to get the list of all the file names from a folder in Excel. Function GetFileNames(ByVal FolderPath As String) As Variant Dim Result As Variant
Dim i As Integer Dim MyFile As Object Dim MyFSO As Object Dim MyFolder As Object Dim MyFiles As Object Set MyFSO = CreateObject("Scripting.FileSystemObject") Set MyFolder = MyFSO.GetFolder(FolderPath) Set MyFiles = MyFolder.Files ReDim Result(1 To MyFiles.Count) i = 1 For Each MyFile In MyFiles Result(i) = MyFile.Name i = i + 1
Next MyFile GetFileNames = Result End Function The above code will create a function GetFileNames that can be used in the worksheets (just like regular functions). Where to put this code? Follow the steps below to copy this code in the VB Editor. Go to the Developer tab. Click on the Visual Basic button. This will open the VB Editor. In the VB
Editor, right-click on any of the objects of the workbook you’re working in, go to Insert and click on Module. If you don’t see the Project Explorer, use the keyboard shortcut Control + R (hold the control key and press the ‘R’ key). Double click on the Module object and copy and paste the above code into the module code window. How to Use this
Function? Below are the steps to use this function in a worksheet: In any cell, enter the folder address of the folder from which you want to list the file names. In the cell where you want the list, enter the following formula (I am entering it in cell A3): =IFERROR(INDEX(GetFileNames($A$1),ROW()-2),"") Copy and paste the formula in the cells below
to get a list of all the files. Note that I entered the folder location in a cell and then used that cell in the GetFileNames formula. You can also hard code the folder address in the formula as shown below: =IFERROR(INDEX(GetFileNames("C:\Users\Sumit\Desktop\Test Folder"),ROW()-2),"") In the above formula, we have used ROW()-2 and we started
from the third row onwards. This made sure that as I copy the formula in the cells below, it will get incremented by 1. In case you’re entering the formula in the first row of a column, you can simply use ROW(). How does this formula work? The GetFileNames formula returns an array that holds the names of all the files in the folder. The INDEX
function is used to list one file name per cell, starting from the first one. IFERROR function is used to return blank instead of the #REF! error which is shown when a formula is copied in a cell but there are no more file names to list. Using VBA Get a List of All the File Names with a Specific Extension The above formula works great when you want to
get a list of all the file names from a folder in Excel. But what if you want to get the names of only the video files, or only the Excel files, or only the file names that contain a specific keyword. In that case, you can use a slightly different function. Below is the code that will allow you get all the file names with a specific keyword in it (or of a specific
extension). Function GetFileNamesbyExt(ByVal FolderPath As String, FileExt As String) As Variant Dim Result As Variant Dim i As Integer Dim MyFile As Object Dim MyFSO As Object Dim MyFolder As Object Dim MyFiles As Object Set MyFSO = CreateObject("Scripting.FileSystemObject") Set MyFolder = MyFSO.GetFolder(FolderPath) Set MyFiles
= MyFolder.Files ReDim Result(1 To MyFiles.Count) i = 1 For Each MyFile In MyFiles If InStr(1, MyFile.Name, FileExt) 0 Then Result(i) = MyFile.Name i = i + 1 End If Next MyFile ReDim Preserve Result(1 To i - 1) GetFileNamesbyExt = Result End Function The above code will create a function ‘GetFileNamesbyExt‘ that can be used in the
worksheets (just like regular functions). This function takes two arguments – the folder location and the extension keyword. It returns an array of file names that match the given extension. If no extension or keyword is specified, it will return all the file names in the specified folder. Syntax: =GetFileNamesbyExt(“Folder Location”,”Extension”) Where
to put this code? Follow the steps below to copy this code in the VB Editor. Go to the Developer tab. Click on the Visual Basic button. This will open the VB Editor. In the VB Editor, right-click on any of the objects of the workbook you’re working in, go to Insert and click on Module. If you don’t see the Project Explorer, use the keyboard shortcut
Control + R (hold the control key and press the ‘R’ key). Double click on the Module object and copy and paste the above code into the module code window. How to Use this Function? Below are the steps to use this function in a worksheet: In any cell, enter the folder address of the folder from which you want to list the file names. I have entered this
in cell A1. In a cell, enter the extension (or the keyword), for which you want all the file names. I have entered this in cell B1. In the cell where you want the list, enter the following formula (I am entering it in cell A3): =IFERROR(INDEX(GetFileNamesbyExt($A$1,$B$1),ROW()-2),"") Copy and paste the formula in the cells below to get a list of all the
files. How about you? Any Excel tricks that you use to make life easy. I would love to learn from you. Share it in the comment section! You May Also Like the Following Excel Tutorials:
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